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Learning Outcome 1

Summary of Learning Points
In this section you’ll learn about:

♦ Basic terminology relating to computers.

♦ Computer hardware.

♦ Computer software.

♦ Using the keyboard and mouse.

♦ Files and folders.

♦ Opening and closing Microsoft Word.

♦ Opening, saving, printing and closing documents.

♦ Using the Help system.
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1.1 Basic Terminology Relating to Computers
The language that is used in connection with computers can be confusing for the first-time

user. The aim here is to help you understand this language and so become comfortable with

it. In the following sections you’ll learn about individual types of hardware and software.

Below are definitions of some of the most common terms; you’ll find definitions of all the

terms used in this manual the first time each of them is used and also in the Glossary at the
end of this document. New terms are shown in italics the first time they’re used.

Hardware

The hardware of your computer is the physical machinery — the monitor, the

keyboard, the mouse etc.

Software

The software is what makes your computer do things. For example, Microsoft

Word is a software program (list of instructions) that allows you to create

documents, usually for printing. Another piece of software on your computer is

responsible for displaying (on-screen) the characters you type using the

keyboard.

Your software programs are usually kept on your hard disk (the permanent disk that is part

of your computer), and copied into memory (storage area where programs and files are kept

while processing takes place) when required. You can think of your disk and memory as

being like a filing cabinet and your desk: your programs are kept in the filing cabinet (disk)

until you need them, when they are placed on your desk (memory) so you can work with
them. When you have finished working with them, they are returned to your filing cabinet.

Information Technology

Sometimes shortened to IT, information technology is the use of computers in the

management and processing of information. This is why, in some companies, the computer

department is called the IT Department.
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1.2 Computer Hardware
One of the most common types of computer in use today is the Apple Macintosh. This is the

type of computer you may have at home, at school or in the office. Here you’ll find out what

the various parts are called and the part they play in making the computer work.

The Outside

The ‘box’ part of your computer is called the system unit. It houses the various parts that act

together to make your computer work. Your system unit may be on your desktop perhaps

with the monitor on top, or it may be a tower that sits on the floor, saving space on your

desktop. You may also have a number of external peripherals (hardware that plugs into your

computer), for example, an external modem (device used for connecting to the internet),
speakers, a printer or a scanner.

The Inside

Inside the system unit there is a flat circuit board called the logicboard.

Attached to this board are the vital components of the computer,

including the CPU (Central Processing Unit), which is explained below,

and the hard disk where your saved information is usually stored. The

logicboard also houses the Boot ROM chip (Bootstrap Read Only Memory). The Boot ROM

consists of one Megabyte of on-board flash EEPROM (electrically erasable programmable

read-only memory). The boot ROM includes all the code required to control the keyboard,

display screen, disk drives, and a number of miscellaneous functions. It is needed to run the

POST (Power On Self Test), to load the operating system, and to provide common hardware

access services.  This chip bridges the gap between the hardware and the operating system,

and is responsible for communicating with all the major components and passing control

over to the operating system software when the Power button is pressed.

Also inside the computer is the RAM (the ‘short-term’ memory), comprising a number of

chips that ‘plug in’ to the logicboard. There will also be one or more hard disks and, if

appropriate to your system, an optical drive such as a DVD-RW (Digital Versatile Disc Re-

Writer). Depending on your Mac’s configuration, you may also have other components such

as an internal modem for dial-up internet access and perhaps an ‘AirPort’ wireless network

card to allow you to connect to other computers wirelessly.

Monitor — also known as
VDU or screen.

Speakers are an example of a
peripheral device.

Keyboard

System Unit — you might

find this is a separate unit
rather than being attached to
the monitor.

Mouse

Printer



PC Passport Support Materials (Macintosh)

Word Processing Student Workbook — Beginner 5

Central Processing Unit (CPU)

The CPU is a chip on the logicboard of your computer. It is here that the

processing required by your task takes place. Processors vary in speed –

the faster the chip, the faster the processing will be carried out. It is

responsible for the running of all programs, including the operating system, and uses a small

portion of memory allocated specifically to it to perform this and the millions of calculations

needed to keep the system operating. This function is highly complex as the CPU must
attend to the various needs of different parts of the system at the same time.

The speed of the CPU is expressed as Megahertz (MHz), and more recently Gigahertz

(GHz), and the higher the rating, the faster the processor. The typical rating of a modern

system is around 1,200 MHz (or 1.2 GHz), but given the rate of change in the computer
world, this increases frequently.

The Connections

At the back or on the side of the computer are the connection points where you can attach

the various parts of your computer, including the monitor, mouse and keyboard. These

connection points are called ports. The USB ports allow connection of peripheral devices

such as a printer, digital camera and/or a scanner. To connect peripheral devices such as a

digital video camera or iPod, the FireWire port may used. This port is designed for

maximum communication efficiency and ease of connection but it’s quite new and is only

available as standard on computers made from around 1998. Anything plugged into the

computer, for example the mouse, keyboard, monitor, scanner or printer is called a
peripheral device.

Removable Storage Media

There are a number of popular forms of removable data storage in use. Some of these are

detailed below.

Storage Method Capacity

Floppy disks can be used to move or copy information from one

computer to another, or to hold a backup copy of your data in case

your system fails or you lose the data another way. These disks are

3.5 inch plastic squares containing a thin magnetic disk. In terms of text

only, you could store roughly one standard dictionary on a floppy disk.

1.44 MB

Memory sticks are a newer type of storage. These come in a

variety of forms and the most common type is connected to your

computer via the USB port, which means that on the newer

versions of Mac OS, for example, you simply plug them in and use them.

Like floppy disks you can take files from one computer to another on a

memory stick, however they hold much more information.

32 – 512 MB

A Zip disk is like a floppy disk, but is physically larger and can

store more data, usually starting from 100 MB, although you can

buy disks with larger capacities. To use these disks you need a zip

drive which these days you usually plug in to your computer, but you can
buy a Mac that has a zip drive built into the system unit.

100 – 750

MB
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One CD-ROM (Compact Disk-Read Only Memory) can hold

the same amount of data as about 500 floppies, although this

varies from manufacturer to manufacturer and increases as

technology advances.  Using a CD-ROM drive (the device used

to read/write a disk) equipped with a special laser, known as a CD-writer,

the drive can write, or burn, information onto a blank disk. Using a CD-

writer, a disk can be written to only once. Using a CD-Rewriter and special

CD-RW (Compact-Disk Re-Writable) format disks, the user can write to the

disk a number of times, and also delete files from the disk, making it like a

very large floppy disk.

780 MB

A DVD (Digital Versatile Disk, or Digital Video Disk) can hold a lot more

information than a CD-ROM due to the use of a built-in second disk. The

information on a DVD is read by the DVD drive at a much faster rate than a

normal CD. A film, cinema quality sound and special features can all be

stored on a single disk. To burn a DVD you will require a SuperDrive in

your Mac or a DVD-Writer that plugs into your Mac.

1.4 – 9.4 GB

Tapes and tape cartridges are also widely used by large organisations

although because of their low access speeds, they are mainly used for

long-term storage of data. Their main use is backing up data in case of loss.

20 – 40 GB

Input Devices

Keyboards and Pointing Devices

The keyboard is the primary input device for the computer and

contains three distinct areas. The Alphanumeric keyboard

makes up the main area of the keyboard and includes the most

common punctuation marks and symbols. The Function keys

run in a straight line along the top of the keyboard, and

perform different commands for different programs. The arrow

keys (also known as the cursor keys) provide additional

navigation to supplement the use of the mouse.

The mouse is essential to modern computing as most programs are operated using a

Graphical User Interface (GUI). This system uses small pictures called icons to

represent what tasks are linked to them. If, for example, you double-click the

Microsoft Word icon, the Microsoft Word program will start.

The mouse is so called because of its appearance, and can include different button

configurations. The basic version for a Mac has one button, but you can buy other versions

with more than one button and/or a special roller button for scrolling. The undercarriage of

the standard Mac mouse contains a small chamber with an optical laser tracking movement

which sends navigation commands via a beam of infra-red light allowing you to control the

movement of the pointer on the screen, or desktop, by pushing the mouse along a flat

surface. The undercarriage of an older mouse contains a small chamber with three rollers

and a ball instead of the optical laser tracing movement. The most modern mouse designs
are wireless, sending navigation commands via a short range radio wave.

The keyboard and mouse are covered in more detail later.
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There are many other forms of pointing device available. On hand-held and some portable

laptops, a light pen is used to point and draw items directly on to the screen, but this feature

can be incorporated into any normal computer using a special pad and compatible software.

Trackballs use the same principal as the mouse, but place the ball from the underside of the

mouse on top, allowing your hand to move the ball and the pointer. This is useful for graphic

designers, or anyone who requires a level of precision that the mouse cannot provide. Touch-

pads and pointer-sticks are found on some laptops and function similarly. For people wishing

to play games such as flight simulators or driving games, there are joysticks and steering

wheels available that carry out the same tasks as real-life joysticks and steering wheels.

Speech

Not everyone can type proficiently, or quickly. The mouse has gone some way to balancing

this, but it has been in the last few years, with the advent of the computer linked microphone

and speech recognition programs, that real advances have been made. It’s already possible to

dictate a letter using such a program, and after an initial period of training the computer will
understand your voice. These programs can understand and display what you say.

Graphics

Recent input devices include those that allow you to read images into your computer. This

process is called digital imaging. Digital cameras and video cameras don’t need film; instead

they use a memory card. The software that is supplied with digital cameras allows you to copy

the images from the memory card to a computer disk. They are capable of good to high

quality pictures and video, and allow manipulation of these images using a suitable graphics

package. This is useful for removing defects, or simply enhancing a dull photo.

Web cameras (webcams) are becoming a popular means of communication via the internet in

that they can be used to see the person to whom you are speaking. For example, when time or

distance issues mean you can’t meet with someone in person, you can use a webcam to see

the person as you speak with them.

Scanners are used to transfer photographs, text, or other items on to

your computer. There are different types of scanner. Flatbed scanners

look like a photocopier, and the item to be scanned is placed on a glass

plate as the scanning head passes below, allowing you to scan books or

bulky objects. Sheet fed scanners look like fax machines, with one page

at a time being fed into the machine. It is then scanned and returned. A

hand-held scanner is also available. This scans when the device is

dragged over text and images on a page.

 Tablets (or digitising tablets to give them their proper name) can be used to

draw pictures using a special pen (also known as a stylus) that uses electronics

rather than ink to draw. Each point on the tablet represents a point on the screen

and when you drag the pen over the surface of the tablet, the tablet sends a
signal to the computer, allowing you to enter your drawing onto the computer.
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Output Devices

Monitors

The screen, or monitor, allows you to see what is happening on your system. For example, if

you were typing a letter, you would see the letters appear on-screen as you pressed the keys.

There are also different types of screen or Visual Display Unit (VDU). The most

common is the same system used in a television and the most basic units are

about the size of a 15" portable TV. This unit is usually included when you buy

a new computer. The second is a Liquid Crystal Display (LCD), which is the

same as a hand-held TV. This is usually extra to a computer package, but much
thinner, with some units taking up no more than 20" x 12" x 5" on the desktop.

Printers and Plotters

A printer allows you to see in hard copy the document that you have

prepared. Once again there are a number of types available. Probably

the most popular is the laser printer, which is faster and quieter than

earlier printer types. Other types include the inkjet printer, which is a

popular choice for home systems.

The price is not the only cost that you need to consider if you plan to buy a printer. You will

also have to replace the disposable ink or toner cartridges when they run out. If you’re

planning to buy a printer, you may find it useful to find out how many pages the cartridges
for that printer will print.

When it is necessary to print something unusual, or technically precise, a special machine

called a plotter is used. This machine outputs very high quality images on various paper sizes,

and would be used by design companies and architects. Whereas a printer draws lines by
placing a series of dots very closely together, a plotter uses a pen to draw continuous lines.

Multimedia Projectors

You may also wish to present information on the computer screen

to many people at once, without printing. A useful device for this

is the multimedia projector. This can be connected to the computer

and used to display presentations or demonstrate a particular

procedure as a projected image. There are many presentation

programs that lend themselves to this device; Microsoft

PowerPoint, Apple Keynote and Lotus Freelance Graphics are
examples of this type of program.

Sound

Most modern software includes sound as a package of warning and alert sounds for

programs, or as music or speech, however speakers are needed if all sounds are to be heard.

Your Mac may have built-in speakers; some speakers come attached to the monitor, and

some are entirely separate. Either way, these are useful for realising the full potential of the

internet, your computer, and your software. Speakers are also useful for allowing the

visually impaired to operate computers. Using a sophisticated program called a speech

synthesiser, the computer can talk to the user and tell them what is happening on-screen.
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Switching On Your Computer System

When you want to use your computer, you have to switch on the various hardware

components individually. First, press the power button on the system unit. You’ll find the

power button on the front, back or side of the unit depending on which model you are

working with. Next, if you have a separate monitor, switch this on. The monitor power

button is usually found on the front. Then, if you have them, switch on your printer, scanner

and any other peripherals. Power switches on these peripherals can be located on the front,

top, side or back of the hardware.

Note: If you have older equipment, you might find you need to switch on your peripherals

first, as older operating systems were designed to recognise peripherals on start up.

When you switch on your computer, Mac OS X will be loaded and the desktop will be

displayed. What this looks like will vary with each computer, and will depend on the version

of Mac OS X, the programs installed on the computer and how it’s been used in the past. All

desktops, though, will have a menu bar, along the top of the desktop. This menu bar

contains the Apple menu, which can be used to access all settings on your computer via

System Preferences. This is the Mac OS X menu bar:

Switching Off Your Computer System

When you have finished using the computer, you should shut it down and switch it off.

It’s important that you shut down your computer properly using the Mac software so that all

your files and settings are saved correctly for next time. Otherwise, you might find that some

of your files or settings become corrupt and so your computer doesn’t work properly, or you
lose your work.

To shut down your computer, choose Shut Down after clicking the Apple menu and then

follow any additional instructions.

You will usually find that your system unit switches itself off once you have shut down.

However, if it doesn’t, you can switch off the hardware by pressing the power buttons.

Exercise 1.1

Now do Exercise 1.1 in the Exercise Booklet.
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1.3 Computer Software
The single most important piece of software on your computer is known as the system

software, or the operating system (OS). This program is loaded when you first start up the

computer, and is responsible for communicating and managing the software and files saved

on your system. Mac OS X is the most commonly used operating system on the Mac. This,

like most other software programs, is updated regularly and so there are a number of

different versions available, for example, 10.0, 10.1, 10.2 ‘Jaguar’ and 10.3 ‘Panther’. When

you buy a new Mac, Mac OS X will be part of the package. If a newer version is released,
you can buy it to upgrade your Mac’s operating system.

Before Mac OS X, the Mac used an operating system called Mac OS 9. Even although you

are running Mac OS X on your computer, you may also have Mac OS 9 on your Mac as it is

required to run older software. This compatibility mode is called Classic mode.

Application software is the name given to a program that performs a task for the user, for

example, Microsoft Word and the word processing part of AppleWorks allow the creation,

editing and printing of documents, while Microsoft Excel and the spreadsheet part of

AppleWorks are used for creating spreadsheets and tables. AppleWorks is usually supplied
with your Mac and other software usually has to be purchased separately.

There are many different types of software and many different manufacturers. For most

common applications, you will find that there are a number of programs, or packages, from

which to choose.

Operating System Software

The designers of system software decided that it would be easier if the users didn’t have to

speak the computer’s own language, so they developed what is known as a Graphical User

Interface (GUI, pronounced goo-ey). Mac OS X is an example of this, as is Microsoft

Windows on a PC. On GUI systems, the user can communicate with the computer and the

application software using pictures that represent the function they carry out.

The introduction of GUIs made the personal computer easier to use for ‘normal’ people as

there was no special language to learn and the GUI was much easier to use and understand
than older command line operating systems.

Since most manufacturers design their programs to look and act in a similar way, you can

quickly pick up the basics even if you have never worked with a particular application.

The screen that is presented to you once the system software is loaded is called the desktop.

The desktop is explained on the next page.
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The Max OS X Desktop

The exact appearance of your Mac OS X desktop will depend on when and how the

operating system was installed on your computer as well as what changes have been made

since it was installed, as each user can change the desktop to suit the way they work.

For example, although the Mac OS X desktop may have a set background to begin with, you

can choose from a number of other backgrounds (or desktop pictures) or even download

backgrounds from your favourite internet sites. This is an example of a desktop with an

Apple background:

Volume — you can click here
to adjust the volume of the
sounds on your computer.

Desktop
Desktop icon —
double-click to open.

Finder — a program

used for working with
files and folders, eg to
create, move, copy,

rename, search for, or
delete them.

Trash — drag files and

folders here to delete
them

Dock – used to start
programs using just a single

click.
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Applications Software

Microsoft is the main software designer for productivity software in use in business and

education today. Although users have a choice of which programs to buy and use, many

choose the familiarity of the Microsoft name. However, many other companies produce

similar applications, including Apple, who produce AppleWorks word processing,

spreadsheet, database and desktop publishing software as alternatives to Microsoft’s Office

range of products, and Sage who produce payroll and accounting applications. The most

common types of application package are described below:

Application Examples Typical Use

Word Processor Microsoft Word,

AppleWorks and Lotus
WordPro

Creating, formatting, editing and printing

documents. Examples are letters, memos,
and faxes.

Spreadsheet Microsoft Excel,

AppleWorks and Lotus

1-2-3

Creating, calculating, formatting, editing and

presenting numerical information. Examples

are budgets, invoices, and payroll.

Presentation

Graphics

Microsoft PowerPoint and

Apple Keynote

Creating and presenting slides for electronic

slide shows or overhead projection. Also

used to create simple graphics-based printed

documents such as posters.

Database AppleWorks and

FileMaker Pro

Storing, retrieving and presenting

information on a specific topic. Examples

include stock control, employee information
systems, and sales order processing.

Computer-based

Training (CBT)

Available on a very wide range variety of

topics from computer theory to word

processing, this software allows you to use

your computer to learn — usually using a

mixture of theory and practical exercises.

Although CBT allows you to work at your

own pace and at a time and place that suits

you and your lifestyle, some people find the

lack of interaction with others a problem,

and others can find it difficult to motivate

themselves.

Web Browser Safari and Microsoft

Internet Explorer (which
come with Mac OS X)

This software allows you to browse the

internet.

E-mail and

Calendar

Mac OS X Mail,

Microsoft Outlook and

Microsoft Entourage

Sending and receiving electronic mail.

Calendar programs allow you to keep track

of your activities, with some offering the

facility to arrange meetings with your

friends and colleagues.

Anti-virus McAfee Virex and

Symantec Norton
AntiVirus

Protecting computer systems from damage

by viruses by detecting their presence and
alerting the computer user.
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1.4 Using the Keyboard and Mouse

Using the Keyboard

Learning to use a keyboard is an essential part of learning to use a computer, as it is used to

type text and issue commands to the computer.

Here you can see that the computer keyboard is like a typewriter keyboard as it has the same

arrangement of letter keys. This part of the keyboard is often called the QWERTY keyboard

after the order of the letters on the top row, although it’s also sometimes referred to as the

Alphanumeric keyboard. In addition to this, a computer keyboard has additional keys.

Some of the main keys highlighted above are explained here:

The [ENTER] key: This key is one of the most important keys on the keyboard. The [ENTER]

key is normally used to execute commands.

The Function keys: These are used within different programs for different functions.

The [SPACEBAR]: The [SPACEBAR] lets you type spaces between words.

The [BACKSPACE] key: The [BACKSPACE] key is used to correct mistakes as you type.

The Cursor keys (or arrow keys): When you’re editing a file, these keys allow you to move

around the file to the point where you want to make changes. In a word processing

document, your position within the file is marked by the cursor.

Function keys [ENTER] key[BACKSPACE] key

Numeric keypad

Cursor (or arrow) keys

[SHIFT] keys

[SPACEBAR]

[COMMAND] keys

[CONTROL] keys
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The Numeric Keypad: When the Num Lock is switched on (shown by a light, usually at the

top right of the keyboard), this keypad will type the numbers shown on each key. When the

Num Lock is switched off, these keys act as cursor keys.

The [SHIFT] keys: When you press one of the letter keys, you will type a lowercase (small)

letter. If you want to type uppercase (or capital) letters, hold down one of the [SHIFT] keys

while you press the letter key. Another use for this key is typing symbols that appear at the

top of keys that contain more than one symbol. For example, if you press the key on the

main keypad that shows 7, a 7 will be typed. However, if you hold down [SHIFT] as you

press this key, the ampersand will be typed: &.

Note: If you want to type everything in capitals rather than just one or two letters, you can

avoid holding down [SHIFT] all the time by pressing [CAPS LOCK] once, which

will switch on capitals until you press [CAPS LOCK] again. This key is above the

left-hand [SHIFT] key.

The [COMMAND] keys: Along with the [SHIFT], [CTRL] and [ALT] keys to the left of

the [SPACEBAR], the [COMMAND] keys are modifier keys. This means that pressing a

key while holding down one of these modifier keys changes what that key does. For

example, when you press the F key by itself, you type a lowercase f; when you hold down

[SHIFT] and press F you get a capital F; when you hold down [COMMAND] and press F,

the Find facility starts.

Using the Mouse

You use the mouse to choose options and carry out tasks. If you haven’t used a mouse

before, you will need some practice to become comfortable with it. There are a number of

basic techniques that you must master to make best use of the mouse.

Technique Use

Pointing For many tasks on the computer you have to

select items so that the program knows what

you want to work with. For example, if you

wanted to delete a graphic, you’d have to

select it first so that the correct image is

removed when you choose the delete
command.

The first part of selecting an item is to point

to it using the mouse as shown here.

Pull or push the mouse in the

direction you want the arrow

to move on the screen until

the arrow is pointing where

you want it to.
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Clicking and Double-clicking The second part of selecting an item is to

click the mouse button. On the current Apple

Mouse, the whole top shell acts as the
button.

Although a single click like this will select

some items, others require you to double-

click, which means pressing the mouse

button twice in quick succession. Some

applications also make use of triple clicking

(three quick clicks) and even quadruple

clicking (four quick clicks) to select

increasing amounts of information; however,

there are always alternatives that are simpler

for some people to use. When used with

icons, double-clicking can also be used for

opening items such as folders and for

running programs.

Dragging Dragging is a technique that involves

clicking and holding down the mouse button

while you pull (drag) the mouse across the

desk. For example, you may drag a window

to another location on the desktop, or drag

over a block of cells to select the cells you

want to work with.

Control-click Control-click is the term used for holding

down the [CTRL] key and clicking the

mouse button.

When you point to an item, hold down the

[CTRL] key and click the mouse button, you

will see a small menu displaying a list of

options. This is called a shortcut menu or

contextual menu, as the options displayed

relate to the item you are pointing to. For

example, if you point to the desktop and

control-click, the shortcut menu will display

options to open a new folder, and change the

desktop background amongst other options.

Clicking:

Press the mouse button once and

let go.

Double-clicking:

Press the mouse button twice in

quick succession.

Hold down the mouse button

while you drag the mouse.

Hold down the [CTRL] button

and click the mouse button.
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Running Out of Space

When using your mouse, you may find it gets close to the edge of the desk, making it

awkward to work with. If this happens, simply lift the mouse off the desk and put it down

where you can move it freely again.  You will find that the mouse pointer doesn’t move

when the mouse is lifted off the desk. If you run out of space when you’re dragging, keep

the button pressed while you lift and replace the mouse.

Playing a Game of Chess to Practice Using the Mouse

If you’re new to the art of using a mouse, you might find playing games is a good way to

practise your technique and have fun at the same time. In fact, Mac OS X comes with a

Chess game, although if you are using a computer in an office, school or public learning

centre, you might find that this game has not been installed or has been removed.

To Start a New Game of Chess

1. Click the Go menu then select Applications. In the window that opens look for an icon

representing the Chess game and double-click it by pointing at the icon and clicking the

mouse button twice quickly.

2. The following window will open. Try dragging the Chess pieces to play a game with the

Computer. If you are stuck choose Show Hint from the Moves menu.

Exercise 1.2

Now do Exercise 1.2 in the Exercise Booklet.
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1.5 Understanding Folders and Files
When you use a program on the computer to create information that you want to keep,

you create a file that will be kept on a disk. There are many different types of files, each

created by a different type of program, eg documents, spreadsheets, graphics files, and
databases.

Folders are simply containers for these files. By organising your files into folders

you, and others, can keep track of your files, finding them quickly and easily when
you need them.

Understanding How Folders Are Organised

Below is a diagram of a manual filing system and its computerised equivalent. The

computerised system is much like a manual filing system where folders are equivalent to the

drawers and compartments in a very large filing cabinet, while files are the sheets of paper

containing the stored information. You may have further divisions of the filed information,

depending on what’s the best way to file it. For example, someone working on a number of

different projects may choose to create a folder to hold all their projects, and inside that, one
folder for each project so that the files relating to the same project can be kept together.

On the other hand, a secretary working for two business partners may create a filing system

that organises documents by the partners’ names and then the document type.

Projects filing cabinet Projects folder on My Computer's local disk

Partner 1

Partner 2

Current
project 1

Current
project 2

Files within
current
project 2

Partner

Partner 2
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The Finder

The Finder is a program you use for working with files and folders, eg to create, move,

copy, rename, search for, or delete them.

The Finder is always running but to open or activate a Finder window you can click on the

Finder icon in the Dock.

Finder windows are split into two panes, with disks and a customisable list of folders in the

left pane and the folder contents in the right pane.

The look of the Finder is highly customisable, so your windows might vary from those

shown, however the function of the program will be the same. For example, you can change

the way Applications, folders, documents, and other items appear in Finder windows. You

can choose to view items as icons, in a list, or in columns. You can also change the size of
the icons and the icon text.

To see the items in a Finder window displayed as icons, in a list, or in columns, click a View

button along the top of the window.

Note: It is possible to have multiple Finder windows open. Choose New Finder Window

from the File menu.

Looking Inside a Disk or Folder

To see the contents of a disk or folder which appears in the sidebar, simply click its icon in

the sidebar and you will then see the disk or folder’s contents in the contents pane at the
right.

Sidebar Folder contents

View Buttons

Icon View Column View

List View



PC Passport Support Materials (Macintosh)

Word Processing Student Workbook — Beginner 19

Expanding and Collapsing Drives and Folders

When you are viewing a window in List view, if a disk or folder contains further folders

(subfolders), it has a small arrow displayed next to it in the folders list. By clicking this

arrow, you expand the object to show its subfolders.

When you expand the disk or folder, the arrow changes direction and points downwards. If

you click the downward facing arrow, the object collapses and its subfolders are hidden

again.

Copying and Moving Folders and Files

The Finder can be used for managing folders and files on your system. You can move them

from one place to another, or copy them to somewhere else so that you have more than one

copy.

To Copy or Move a Folder or File

1. Display the folder or file you want to work with.

2. Click the folder or file once to select it.

3. To copy the item, select the Edit, Copy menu option or hold down [COMMAND] and

press C.

4. Navigate to the folder where you want to place the copied folder or file.

5. Select the Edit, Paste menu option or hold down [COMMAND] and press V.

The copied item will be placed in this folder

Note: As with most tasks in Mac OS X and its programs, there is usually more than one

way of doing things. The procedure above shows you two of the most popular ways

to copy files and folders (one using the mouse and one using the keyboard).

However, there are others you may find easier to use. These include dragging the

files or folders to the location that you want to move them to.

Click the arrow … … to see subfolders
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Creating Folders

You can create folders using the Finder. To do this, make sure you are currently in the drive

or folder where the new folder is to be placed then choose the File, New Folder menu

option. Type a name for the folder then press [ENTER].

You can also create folders on the desktop. Click on the desktop then choose New Folder

from the File menu.

Deleting Folders and Files

The Finder can also be used for removing files and folders from your system when you no

longer use them. If you delete a folder, any subfolders and files it contains will also be

deleted.

To delete a file or folder, simply select it by clicking it and then choose the File, Move To

Trash menu option or click on the file or folder and drag it to the Trash icon in the Dock.

When you delete an item from your hard disk, it isn’t permanently removed from your disk

straight away. It is moved to the Trash and stays there until you ‘empty’ it. This means that

if you discover that you do, in fact, still need the item you have moved to the Trash, you can

recover it up until the point where you empty the Trash.

You can display the contents of the Trash by double clicking the Trash icon on the dock.

To permanently delete the contents of the Trash, click on the Finder menu at the top of the

screen, and select the Empty Trash option.

Drives and Folders in Word

When you want to open or save a document in Word, or in any other application, you will

have to specify where it is or where you want to put it. When you understand the way that
drives and folders work, this becomes an easier task.

In this dialog box, which is shown when you want to save a file, you can see that the

disk/folder structure that you’ve seen in the Finder is duplicated here. You’ll learn more

about this later.

Folder where letters
concerning Alan Falls
would be saved.
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Exercise 1.3

Now do Exercise 1.3 in the Exercise Booklet.
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1.6 Opening and Closing Microsoft Word

Opening Word

You can load Word in a number of ways. The most popular method is using the Dock which

appears on the bottom of the screen. However, the Dock must first be customised to include
an icon for Word.

♦ Choose Applications from the Go menu. Look for the Microsoft Office folder and

double-click to open. Drag the Word icon from the folder to the left hand side of the

Dock. You can now launch Word with one click from here.

Word Screen Elements

When Word is loaded, the application window will be displayed.

Some of the screen elements in this window can be switched on and off, so your screen may

look slightly different from the illustration below.

Microsoft Word after being
dragged into the Dock.

Ruler — displays margins,
indents and tab settings.

Insertion point —

shows where the
text you type will
appear.

Toolbars

Formatting Palette — contains font,
style, alignment options.

Title bar — shows the name
of the current document.

Menu bar — contains menus of options.

Close, Minimise and Maximise buttons.

Drawing Toolbar
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Title Bar

When Word is loaded you will see the application window, which has a title bar displaying

Document1, although Document1 will change to the name you give the document when

you save it. The Word window has standard window elements such as the Minimise and

Maximise buttons that you’ll see on all program windows, and like any other window, you

can resize and position the Word window anywhere on the screen.

Menu Bar

By clicking a menu name, you can display the menu options. Once the menu is open, you

simply click the option you require. Some commands can be accessed using keyboard

shortcuts. When a keyboard shortcut is available, you will see it described to the right of the

command name. For example, if you click the Edit menu, you will see the Copy command

can also be actioned by pressing [COMMAND] C. This means pressing C while you hold

down one of the [COMMAND] keys. Options that appear dimmed are not available for

selection at this time. Some of the commands can also be accessed through a toolbar button,

eg Cut, the picture that appears on the button is a pair of scissors.

Toolbars

To begin with, Word displays the Standard and Formatting toolbars. You can choose to

display or hide toolbars using the View, Toolbars command. The Formatting Palette may
also appear.

Ruler

The ruler can be used to set margins, tabs and paragraph indents using the mouse. It will

also display the paragraph settings in effect at the insertion point.

You can choose to display or hide the ruler using the View, Ruler command. This is a

toggle option, meaning selecting it once will display the ruler and selecting it again will hide

it.

Text Area

Below the ruler is the text area representing the page. The flashing mark is called the

insertion point and indicates where text will appear when you start to type.

Scroll Bars

The scroll bars shown along the bottom and right edges of the document window can be

used to view different parts of your document if it’s too large to be seen all at once on the
screen.

Drag this scroll box up and
down the bar to scroll up and

down through the document
text.

Click here to scroll down.

Click here to move to the previous page.
Click here to choose a
browsing method other
than page.

Click here to scroll to the next page.

Click here to scroll right.Click here to scroll left.

Click here to scroll up.
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When you click the arrow buttons at the end of a scroll bar, the text on-screen will scroll in

the direction shown on the arrow. If you want to scroll further, you can click and drag the
scroll box along the scroll bar to the required position.

Status Bar

At the left side of the status bar you will see the current page number, section number and

number of pages in the current document. The next section shows where the insertion point

is positioned on the page and to the right are various indicators, which light up when certain

modes are active. For example, OVR will illuminate when overtype mode is switched on.

When overtype mode is on, characters are replaced as you edit instead of being inserted.

The section of the status bar in the shape of a book is the spell check indicator. Word

constantly checks your spelling as you type. The book will be displayed with a red cross

when Word detects any spelling mistakes in your document and a green tick when there are

none. You can run the spell check by double-clicking this indicator. You will learn more
about spell checking later in the unit.

Closing Word

When you have finished using Word, you should close it. You do this by clicking Word on

the menu bar and then choosing Quit Word from the menu of options.

Exercise 1.4

Now do Exercise 1.4 in the Exercise Booklet.

Spell check indicator

Page number, section
number, number of pages.

Insertion point position. Word Count. Indicators.

This option will close Word and any documents that are still
open. If you’ve made any changes that you haven’t saved,
you’ll be prompted to save them.
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1.7 Opening, Saving, Printing & Closing Documents

Opening a Document

If the document you want to work with has already been typed and saved, you have to open

it before you can work with it.

1. Open the file using one of these methods:

♦ Select the File, Open menu option, ie click the File menu and then the Open option.

♦ Hold down [COMMAND] and press O.

♦ Click the Open button on the toolbar.

The Open dialog box will be displayed.

2. Choose where the document is located, eg on the desktop, or somewhere else on your

Mac. You can use the Sidebar to help you navigate to where your file is stored. You can

also display a list of popular places and recently used places by clicking anywhere on the

Look in box or the small arrow at the end of it. This is known as a drop-down arrow as

clicking it displays a drop-down list.

Note: The Sidebar at the left of the dialog box can be used to quickly list the contents of

the listed folders. Simply click the appropriate button.

Sidebar
Look in box: Click here to
display the drop-down list.
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3. Open the folder where the file has been saved by clicking its name if you are in Column

View and double-clicking its name if you are in List View. For example, in Column

View, if the workbook is in the Projects folder, click the Projects folder. The folder

name will then appear in the Look in box and its contents will be listed in the main

window.

4. Once the folder you want is open and its name is shown in the Look in drop-down list

box, click the workbook name and then click the Open button.

Saving a Document

When saving files to your computer, you can choose to save them in a folder on your

computer’s local hard disk or a floppy disk if you have a floppy disk drive. If you are

attached to a network, you can also choose to save them in a folder on the network. You can
choose to store it in a folder that already exists, or create a new folder for it.

1. Choose to save the file using one of these methods:

♦ Select the File, Save menu option, ie click the File menu and then the Save option.

♦ Hold down [COMMAND] and press S.

♦ Click the Save button on the toolbar.

The Save As dialog box will be displayed.

Drop down list

Main window

List View Column View
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2. In the Save As text box enter a suitable file name. The following rules apply when

naming files.

♦ Some characters should not be used in file names. These include:  / * ? : ; " | < > (

Note: Although the Mac will accept most characters in a filename with the

exception of / and :, it is not good practice to use special characters in your
file name.

♦ Within a single folder each file name must be unique.

Word adds a .doc extension to all document file names. It may be the case, however, that

you do not see the file extension as its display depends on how your system has been set

up.

3. Under most circumstances, you should not need to change the file format, but if

necessary, choose the file format from the Format drop-down list.

4. If necessary, choose the disk where you want to save the file by clicking it. The contents

of that drive, including any files not stored inside a folder, will be displayed in the main

window in the dialog box.

5. Specify where the file is to be saved, eg on the desktop, or somewhere on your Mac by

selecting an option from the drop-down list.

Note: The Sidebar at the left of the dialog box can be used to quickly display the

contents of the folders shown. Simply click the appropriate button.
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6. Open the folder where the file is to be saved by double-clicking its name. For example,

to store the file in the Projects folder, double-click the Projects folder. The Project

folder name will then appear in the Save in box and its contents displayed in the main

window.

If you want to create a subfolder inside the one shown in the Save in box, click the New

Folder button. A new folder will appear in the file and folders list, ready for you to type
a unique name. Type the new folder name then click Create.

7. Once the folder you want is open and displayed in the Save in drop-down list box, click

the Save button.

Note: When you save a file that has been saved before, Excel assumes that you want to

save it on top of the previous version and so doesn’t ask you for a file name or a

location. If you want to save another copy of the file, use the File, Save As menu

option, which will always ask you for a file name and a location.
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Common Text Formats

When you save a Word document it is stored in a particular format, complete with the

formatting that has been applied, the graphics that have been included and so on. The file

name you supply is given a .doc extension (an abbreviation added to the end of the file name
to identify the file type), which tells Word that it’s a Word document.

Word can both read and save your documents in other formats. This is so that you can

exchange data with other programs that can’t read or create Word’s own format. So if, for

example, another user has a different word processing program that can’t read Word files,

you could save the document in one of these other formats for them. The two most common

are plain text and rich text format.

Format Description File

Extension

Plain text This is text that does not contain any special formatting or

special fonts.

.txt

Rich text

format

Rich text format is a format which can hold information

about the formatting and layout of the document. This can

include which fonts are used for text, the size of margins,

how paragraphs are formatted and much more.

.rtf

To open a document in a format other than the standard Word Document format, use the

Enable drop-down list to choose the particular format you want to work with.

To save a document in a format other than the standard Word Document format, use the

Format: drop-down list to choose the particular format you want to work with.

Printing a Document

To print a copy of your document to the default printer, you simply click the Print button on

the toolbar. This button looks like this:    .   There is more about printing in section 3.

Closing a Document

When you have finished working with a document, you can close it by selecting Close from

the File menu.

Exercise 1.5

Now do Exercise 1.5 in the Exercise Booklet.
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1.8 Using Word Help
Like all Microsoft applications, Word provides an online facility for getting help when you

need it.

Word has a comprehensive online help system that you can use when you want to know

more about a particular option or how to complete a task. Described below are some of the

ways you can get help.

The Office Assistant

The Office Assistant provides tips on how to get the best from Word and provides step-by-

step instructions to guide you through specific tasks. It anticipates the kind of help you need

and suggests Help topics based on the work you’re doing. It will also answer Help requests
typed in your own words. Make sure the Help, Use the Office Assistant option is selected.

1. Select the Help, Search Word Help menu option. Alternatively, click the Office

Assistant button at the end of the Standard toolbar, or hold down the [COMMAND]

key and press the ? key. An Office Assistant balloon will be displayed.

2. In the What would you like to do box, enter some key word which explain what you

are trying to do. If you wanted to find out how to open a document for example, you

might type open a document and then click the Search button. You will then be

presented with a choice of help topics to choose from.

3. Click your chosen topic and help text will be displayed or a list of headings will be

shown so you can select more specifically what you would like to do.

This is only one of the Office Assistant animated characters that
are available. It’s called ‘Max’ and usually looks like an old Mac
Classic.

On your system, you might use another of the eight Office
Assistant characters instead of Max, such as ‘Clippy’ the

paperclip.

Office Assistant Button
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4. Click your chosen heading to display the help text.

Exercise 1.6

Now do Exercise 1.6 in the Exercise Booklet.

Summary Tasks

Now do the Learning Outcome 1 Summary Tasks in the Exercise Booklet.
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Learning Outcome 2

Summary of Learning Points
In this section you’ll learn about:

♦ Creating documents.

♦ Entering and editing text.

♦ Formatting.

♦ Inserting graphics.

♦ Spell checking.
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2.1 Creating Documents
Each document created in Word is based on a template that defines its initial appearance and

layout. This means that the fonts, sizes and so on give the document a consistent look and

feel. There are a number of templates for different document types including letters, faxes,
memos and reports and you can create your own if necessary.

If you choose to create a new document using the New Blank Document button on the

toolbar, the document will be based on the default Normal template.

If you want to create a document based on one of the other templates, you have to use the

File, Project Gallery menu option as this will give you a choice of templates to choose

from. Where a category has an arrow beside it, clicking the category will display a number
of sub-categories.

Using Templates

Many of Word’s templates contain text placeholders as shown below. These make it quick

and easy for you to enter the document text at the correct position and in a format in keeping

with the overall style of the document. All you need to do is click a placeholder and then

type the required text.

To enter the recipient (the person receiving the memo),
click this placeholder and then type their name.
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To Create a Document Using a Template

1. Select the File, Project Gallery menu option.

2. Click the disclosure triangle next to the required category if there is one, and any sub-

categories will be displayed.

3. Click on the required category or sub-category on the left side of the Gallery window,

and a selection of relevant options will be displayed in the main window.

4. Click the template you want to use then click OK.

A new document will be created based on the template you chose in the dialog box.

Business
Forms sub-
categories.
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2.2 Entering and Editing Text
When you’re typing text you don’t have to press [ENTER] at the end of each line. Word

uses a feature called word wrap, which ensures the text ‘wraps’ down to the next line when

it reaches the right margin of the document. You need only press [ENTER] when you want

to start a new paragraph or insert space between paragraphs. You would also press

[ENTER] at the end of a short line, such as a heading or a line of an address.

Word has a feature called AutoCorrect that will correct common typing mistakes, for

example if you type teh AutoCorrect will change it to the and if you start to type with the

[CAPS LOCK] key switched on accidentally, Word will switch it off and correct the text

you typed.

Correcting Mistakes as You Type

If you make a mistake that AutoCorrect does not correct, press the [BACKSPACE] key to

delete characters to the left of the cursor (in Word, the position of the cursor is known as the

insertion point). This will move the insertion point back through what you’ve typed, deleting
as it moves.

Note: The appearance of the [BACKSPACE] key can vary from keyboard to keyboard, but

it will always be above the [ENTER] key on the main keyboard. The key might have

the word ‘backspace’ on it along with an arrow pointing left, or just the arrow.

Here’s an example of a [BACKSPACE] key: . Be careful not to mix it up with the left

arrow cursor key.

Example

The word ‘teaching’ has been spelled incorrectly in this example (the red wavy underline

shows the incorrect word). To correct it, you could either press the [BACKSPACE] key

until you remove the t that shouldn’t be there and then re-type the rest of the word, or you

could use the cursor keys to move the cursor back until it’s between the t and the c and then

press [BACKSPACE] once to remove the t (you would then have to use the cursor keys to

move the cursor back to the end of the word before you continue typing).

Note: The [DELETE] key can also be used to remove text from your document. It works

in a different way from the [BACKSPACE] key as it will remove characters to the
right of the insertion point.

Correcting Spelling/Grammar as You Type

As you type, you’ll notice that spelling mistakes are underlined in red and grammatical

errors in green. These wavy lines only appear on the screen: they are not printed along with

the document. To correct a spelling/grammar error, hold [CTRL] and click the word(s) and

Word will suggest how to fix the problem.
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Sometimes Word doesn’t have any alternatives to suggest. If this is the case, you will have

to either edit the word yourself after checking its spelling with another source or choose to

ignore the error. You might choose to do this if you know the spelling is correct but Word
doesn’t recognise it, for example, it may be a surname that Word doesn’t recognise.

Using Undo and Redo

Clicking the Undo button           on the Standard toolbar will undo your most recent action,

but you can click the drop-down arrow next to it to show the list illustrated below so that
you can undo more than one action at a time.

The Edit, Undo menu option can also be used for undoing just your last action or you could

press [COMMAND] Z if you prefer.

If you need to, you can undo up to your last 255 actions in Word. This means that if you

make a mistake, you can undo it. However, you must remember that every action that

you’ve performed since making the mistake will also be undone. For example, in the

illustration below, if you want to undo Border Outside, the Color and Typing actions would

also be undone.

If you undo actions that you shouldn’t have, you can redo them by clicking on the Redo

button          that appears on the Standard toolbar or you can use the Edit, Redo option. The

Redo option will be available only when you have used Undo, and it also has a drop-down
arrow that can be used to select more than one action at a time.

Clicking this drop-down arrow next to the Undo
button shows a list of the most recent actions.

You can undo any

of these actions —
but all actions from
the top of the list to

the one you want to
undo will be
reversed.
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Moving the Insertion Point

Any text that you enter is placed at the insertion point within the document, so before you

type text you have to make sure the insertion point is at the correct position. You can do this
using either the keyboard or the mouse.

To Move the Insertion Point Using the Keyboard

[] Up one line [ALT] [] Left one word

[] Down one line [HOME] Beginning of the line

[] Left one character [END] End of the line

[] Right one character [ALT] [HOME] Beginning of document

[ALT] [] Up one paragraph [ALT] [END] End of document

[ALT] [] Down one paragraph [PGUP] Up one screen

[ALT] [] Right one word [PGDN] Down one screen

NOTE: On iBook and PowerBook models the [HOME] and [END] keys may be on the

cursor keys and require you to hold the [FN] key.

To Move the Insertion Point Using the Mouse

1. If necessary, use the scroll bars to locate the text you want to edit.

2. Once the text is visible, move the mouse to where you would like the insertion point

positioned and click the mouse button.

Selecting Text

Although you can use the [BACKSPACE] key to remove text as you type, sometime you’ll

want to delete more than a few characters at a time. You can do this by selecting the text and

then pressing [BACKSPACE]. There are a number of different ways of selecting text, using

either the keyboard or the mouse, and many of Word’s operations need you to select the text

first.

Selecting Text Using the Mouse — A Word, Sentence or Paragraph

1. Using the mouse, point to the required word, sentence or paragraph.

2. Double-click the word to select the word.

Hold down [COMMAND] and click any part of the sentence to select the sentence.

Triple-click any part of the paragraph to select the paragraph.

Selecting Text Using the Mouse — A Block of Text

1. Click at the start of the text you wish to select.

2. Click and hold down the mouse button then drag over the text, then release the mouse

button.
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Alternatively, click to the left of the first character to be included in the selection, hold

down the [SHIFT] key and click at the end of the required block.

Selecting Text Using the Keyboard

If you prefer to use the keyboard to select text, you can use the arrow keys that you learned

earlier for moving the cursor, but by holding down [SHIFT] as you move the cursor, the

text it moves over will be selected.

Deselecting Highlighted Text

To deselect highlighted text, click anywhere within the document text or press any one of

the arrow keys.

Copying and Moving Text

You can copy or move text within a document or between documents using the same Edit

menu options you used to copy files in the Finder. First select the text to be copied or moved

as described above, then select Edit, Copy or Edit, Cut (Copy to make another copy of the

text, Cut to remove it in preparation for placing it somewhere else). Move the insertion

point to the location where the text is to be placed then select the Edit, Paste menu option.

Note: You can use the same shortcut keys as mentioned before. [COMMAND] C will

copy the selected text; [COMMAND] X will cut it, and [COMMAND] V will paste
text at the insertion point.

Exercises 2.1 and 2.2

Now do Exercises 2.1 and 2.2 in the Exercise Booklet.
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2.3 Formatting Text
Formatting allows you to change the appearance of your documents, perhaps to emphasise

particular parts of it, or perhaps to make it look better. There are two types of formatting you

can apply to your document: text formatting and paragraph formatting.

Text Formatting

Text formatting is formatting that affects the text itself, eg bold text, italic text, font, font

size (also known as point size) or font colour.

Some of these effects can be added using the toolbars and Formatting Palette, while all of

them can be added using the Format, Font menu option.

Formatting Toolbar

To apply formatting effects using the toolbar, first select the text you want to apply the

effect to and then choose the effect. For Bold, Italic and Underline, simply click the

appropriate button to switch it on or off. For the other effects, choose the option you want
from the drop-down lists.

Formatting Palette

Many of the options from the Formatting Toolbar are available in the Formatting Palette. If

you cannot see the Formatting Palette, select Formatting Palette from the View menu.

Extra options are available by expanding the sections.

Format, Font Menu Option

To apply formatting effects using the Format, Font menu option, first select the text you

want to apply the effect to. Next select the menu option and choose the effects you want to

apply. Once you’ve chosen all the effects you want, click OK to apply them to the selected

text.

Font Font size Bold, Italic, Underline Text colour

Click on each section to

expand or collapse the
options.
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Paragraph Formatting

Paragraph formatting is formatting that affects whole paragraphs rather than individual

characters within them, eg the spacing between one paragraph and the next, the space

between the lines of a paragraph, bullets or numbers on lists, paragraph indents (extra space
between the margins and the paragraph text). Some of these effects are illustrated below.

About Indents

This text has been indented by pressing the Increase Indent button on the

Formatting toolbar once. The paragraph begins further in from the margin than the

previous paragraph and the word wrap feature also wraps to this setting. Double

line spacing has also been applied to the paragraph.

o The Increase Indent button has been clicked again to further indent the

paragraph, taking it further in from the margin and bullets have been
applied.

o The Decrease Indent button, if clicked in this paragraph, would move the

paragraph back towards the left margin, continuing to show the bullet.

Some of the paragraph formatting effects that can be added using the Format, Paragraph

menu option can also be applied using the Formatting toolbar.

Text indented by clicking the Increase Indent button.
Double line spacing
has been applied.

Centred alignment

Bullets

A preview of your choices appears here.

Choose a font size from the list or type the
size into the box at the top of the list.

Choose a font from the list.

Choose a font style from this list.

Choose a font colour from this list.
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Formatting Toolbar

To apply paragraph formatting effects using the toolbar, first click in the paragraph or select

the paragraphs you want to apply the effect to and then choose the effect.

Format, Paragraph Menu Option

To apply formatting effects using the Format, Paragraph menu option, first click in the

paragraph or select the paragraphs you want to apply the effects to. Next select the Format,

Paragraph menu option and choose the effects you want to apply. Once you’ve chosen all
the effects you want, click OK to apply them to the selected paragraphs.

Alignment Bullets and
Numbering

Indents

Borders

Choose a paragraph alignment.

Choose left and right indents.

Choose spacing before and
after the selected paragraphs.

Choose spacing between the
lines of the paragraph.

Click OK.
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Format Painter

The Format Painter feature can be used to copy text or paragraph formatting attributes that

you’ve already applied using the techniques you’ve just learned and apply it to other parts of

your document. To use the Format Painter:

1. Select the text or paragraph that has already been formatted with the attributes you want

to apply elsewhere.

2. Click the Format Painter button on the Standard toolbar to copy the formatting. This

button looks like this: .

3. If you copied formatting from text, click and drag over the text that’s to be formatted

with the copied formatting. In this case, only the text formatting will be copied, not the
paragraph formatting.

If you copied formatting from a paragraph, click anywhere in the paragraph that’s to be

formatted in the same way. In this case, the paragraph formatting attributes as well as the

text formatting attributes will be applied.

Note: If you double-click the Format Painter button at step 2, you can repeat step 3 as

many times as you need to. Once you’ve finished, click the button again to switch it
off.

Inserting Page Breaks

When you reach the end of a page a new one is started. Where the end of the page is

depends on the size of paper you’ve told Word you’re using and the margins that you’ve set

(you’ll learn about these settings later). This won’t always suit what you want, eg a

paragraph may be split over two pages if it doesn’t all fit on one page, and you might not

want this. In a case like this you can insert a page break so that the text splits where you
decide.

To insert a page break, move the insertion point to just before the text that is to appear on

the new page and select the Insert, Break, Page Break menu option.

Exercises 2.3 and 2.4

Now do Exercises 2.3 and 2.4 in the Exercise Booklet.
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2.4 Inserting Graphics
Depending on the style and tone of your documents, you might want to add one or more

graphics to add visual interest to the document or to illustrate a point. There are a number of

ways to add a graphic element; these are explained below.

Adding an Existing Picture to a Document

If you have graphics on your computer, maybe a company logo or a picture downloaded

from a digital camera or a scanner, you can add it to your document using the Insert,

Picture, From File menu option. This menu option displays a dialog box similar to this one:

From here, you can locate the graphics file using one of the methods you used earlier to
locate files and then click Insert to add it to the page.

Adding an Image or Graphics File to a Document

Adding ClipArt

A collection of pictures, sounds and motion clips, known as ClipArt, is available as part of

the Microsoft Office suite of programs. When any of the programs is installed on your

computer, a small selection of these is copied to your computer while the remainder are

stored on the program CD-ROM.
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To Insert ClipArt

If you want to use the extended set of ClipArt, ensure the program CD-ROM is in your

computer’s CD drive. Next do one of the following:

♦ Select the Insert, Picture, Clipart menu option.

♦ Click the  ClipArt  button shown on the Drawing toolbar.

 The Clip Gallery dialog box will be displayed.

♦ Choose the type of ClipArt you want by clicking the relevant category.

The available clips will be displayed. For example, if you choose the Animals category,

the following options will be shown (although, if the program CD-ROM is in your CD

drive, or if you have previously added other graphics to the ClipArt collection on your
system, you will be shown a larger selection):

♦ Click the clip you want to use and click Insert.

Graphics
available in
the selected
category.

Categories
available.

Specifies there are 11 clips
in Animals category.
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Wrapping Options

When you add a graphic to a document, it is treated as part of the text, which means that it

will move as if it were text when you edit the document. This is due to the graphics

wrapping style being set to in line with text. Many of the graphics used in this manual use

this wrapping style so that when the manual is edited, the graphics move along with the text
they support.

Note: When an inline graphic is selected, its selection handles are black as in the

illustration below.

Other Wrapping Options

If you prefer, you can change the wrapping style using the Picture toolbar that’s displayed

when a graphic is selected (if it’s not, you can display it using the View, Toolbars menu
option).

Each of the other options on the menu has a small illustration showing the effect it will have.

You can also Double Click your graphic to display the Format Picture dialogue box, and

then click the Layout tab to select wrapping options.

Wrapping options that let you change how
your graphic aligns with the surrounding
text.
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The examples below show some of the different effects you can create by changing the
wrapping options.

The graphic that has been added to this paragraph uses the Square wrapping

style. Each graphic has a square bounding box surrounding it. You

can see this box when you select a graphic — regardless of the

graphic’s shape, the handles are arranged in a square. When you

choose the Square wrapping style, the text wraps around this square bounding

box as you can see here. When a graphic that doesn’t use the In line with text

style is selected, the selection handles are white instead of black and the graphic

can be moved by clicking and dragging it to where you want it.

In this paragraph, the graphic has been formatted with the Tight wrapping style.

When you use this wrapping style, the text surrounding the graphic wraps

around the graphic’s actual shape rather than its bounding box as the

Square option does. You can see there that this text is wrapped around

the circular shape of the graphic. You can move any of the graphics

shown here simply by clicking and dragging, and the text surrounding it will
adjust itself to match the wrapping option applied to the graphic.

This graphic has been formatted with Behind text wrapping. Graphics formatted

in this way sit behind the text on their own ‘layer’. This means that only some

graphics suit this style since any text shown in front of the text still has to be
readable. There is no text wrapping with this format.

This graphic uses the In front of text wrapping style, and as you can see, it

obscures the text sitting behind it. There is no text wrapping with this format

either.

Adding AutoShapes to a Document

Word has a variety of tools you can use to draw shapes that you need in a document, and

these are available from the Drawing toolbar.

This toolbar contains some simple shapes as well as the AutoShapes menu, which contains

some commonly used, ready-made shapes such as stars, crosses, boxes and arrows. To use

any of these tools, simply click the one you want to draw then click and drag the shape in
the document.

The Text Box button lets
you position text wherever
you want on the page.

Draw menu AutoShape menu. This menu lets you add standard
shapes such as lines, arrows, flowchart symbols,
triangles and stars to your documents.
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For instance, to draw a cross from the Basic Shapes category of AutoShapes choose the
shape and then:

Note: To keep the height of the object in proportion to its width, hold down [SHIFT] as

you drag.

Adding Text to Drawings

You can add text to most objects, formatting it however you want in the same way as you

would format any other text, and the text will become part of the shape. To add text, hold

[CTRL], click the shape and choose Add Text from the shortcut menu.

Note: There are some shapes that you can’t add text to. These include lines and freeform

shapes.

Moving Images or Drawn Objects in a Document

When you add a drawing to a document, it’s formatted with the In front of text wrapping

style, so to move a drawn object, click and drag it to its required location. If you want to

move more than one object at a time, you must first select all the objects as described below.

Selecting Objects

Select a single object by clicking it. Select a number of objects by clicking the first object

and then holding down the [SHIFT] key as you click the others.

Selected objects are shown with sizing handles around them as illustrated on the next page:

Click and drag from here …

… to here.

You can add text to objects by holding down the [CTRL] key,

clicking the shape and choosing Add Text from the shortcut
menu.
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Once you have selected your object/image, hold down the mouse button, drag the object to

the new location and then release the mouse button.

Aligning Objects

Clicking on the Draw icon  on the Drawing toolbar and then selecting Align or

Distribute displays options that allow you to place selected objects in relation to one

another. You can line up the edges or centres of the objects as well as distribute them either
horizontally or vertically between the first and the last.

First select the objects to be aligned or distributed then click on the Draw icon on the

Drawing toolbar and select the required option from the Align or Distribute menu.

Note: If you select the Draw, Align or Distribute, Relative to Page option before

choosing an alignment, the option will be aligned in relation to the page instead of in

relation to another object.

Formatting Objects

The fill colour, line colour and style, and text format of drawn objects can be formatted

using the palettes on the Drawing and Standard toolbars. To format drawn objects, first
select them and then choose the required options.

Resizing a Graphic

To resize a graphic or an object, select the graphic or object by clicking it once. Move the

mouse pointer to one of the corner selection handles until the pointer changes to a diagonal

arrow shape then press the mouse button and drag to resize the image. Release the mouse
button when the object is the required size.

Grouping Objects

Sometimes when you’re working with graphics it can be useful to group together several

shapes. This makes it easier as the objects are all treated as one, so when you move one, all

the objects in the group move. To group together objects, first select them all as described
above then click the Draw icon and choose Group.

Exercises 2.5, 2.6 and 2.7

Now do Exercise 2.5, 2.6 and 2.7 in the Exercise Booklet.

Text colour Fill colour

Line colour
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2.5 Checking Your Spelling
Sometimes even the best typist makes a typing mistake. Therefore, Word’s Spell and

Grammar utility can be useful for checking your document for spelling mistakes and

grammatical errors. Word has a built-in dictionary against which each word in your

document is checked, and a ‘custom’ dictionary to which you can add words that are valid in

your documents, but not usually found in an ordinary dictionary. For example, you will

probably add your surname to documents. If your surname isn’t one of those recognised by

Word, it’ll be marked as a spelling mistake each time you type it unless you add it to the
custom dictionary.

As you have seen, Word will alert you through a red or green wavy underline in your

document when it finds what it considers to be an error. You can correct these quickly by

holding [CTRL] and clicking the underlined word or phrase and choosing one of the options
that appear on the shortcut menu.

Alternatively, you can create your document and then check it in one sweep using the Tools,

Spelling and Grammar menu option. This menu option will display the Spelling and

Grammar dialog box below, with the first mistake highlighted in the box.

When Word finds a possible spelling or grammatical error, you’ll be prompted to make your

changes in the Spelling and Grammar dialog box by either ignoring the suggestion or

accepting it. If neither of these options will deal with the issue, you can edit the document
without closing the Spelling and Grammar box and then resume the check.

Once one mistake is dealt with, Word moves on to the next mistake and then the next until

there are no further mistakes.

Click the Ignore button if the

highlighted word is acceptable in
this context or the Ignore All button
if you want to allow the highlighted
word throughout the document.

Click the Add button to add this
word to your custom dictionary.

Click the Change button if you want
to accept one of the Suggestions or
the Change All button to accept

that Suggestion wherever this word
appears throughout the document.
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As an alternative to selecting the Tools, Spelling and Grammar menu option, you can click

the Spelling and Grammar button on the toolbar. This button looks like this: .

Exercise 2.8

Now do Exercise 2.8 in the Exercise Booklet.

Summary Tasks

Now do the Learning Outcome 2 Summary Tasks in the Exercise Booklet.
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Learning Outcome 3

Summary of Learning Points
In this section you’ll learn about:

♦ Changing the page setup.

♦ Previewing documents.

♦ Working with printers.

♦ Using the File, Print menu option.
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3.1 Changing the Page Setup
You can change the layout of your document using the File, Page Setup and the Format,

Document menu options. The Page Setup dialog box allows you to change page attributes

such as the size of paper you’re using and the page orientation. The Format Document

dialog box allows you to set the margins you want to apply, and consists of two parts:

Margins and Layout.

Changing the Page Layout

Select the File, Page Setup menu option. The Page Setup dialog box will be displayed. To

change the paper settings, click the Paper Size drop down box and make the required

selection. You can change the page orientation to Portrait (tall) or Landscape (wide) by
clicking the required Orientation button. Click OK when you have made your selections.

To change the layout options, click the Format menu and select Document. Click the

Layout tab.

Choose paper size from drop-down list or

manually type Width and Height in the boxes
below. The most common setting for Paper size in
the UK is A4.

Select page orientation:

Portrait (tall) or
Landscape (wide) by
clicking required option
button.

Click here to change text alignment.

Click here to number rows.
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♦ Vertical Alignment: By default, text on a page will line up with the top margin of the

document. If you want the contents of the page to be centred between the top and bottom

margins, select the Center option from the Vertical Alignment drop-down list.

♦ Alternatively, if you would like the contents of the page to be spaced out so that the first

line on each page lines up with the top margin and the last line of each page lines up

with the bottom margin, select the Justified option from the Vertical Alignment drop-

down list.

♦ Line Numbers: If you would like each line of text numbered, click the Line

Numbering button and activate the Add Line Numbering check box. Specify the

number that’s to be assigned to the first line and by how much the count should be

increased for each subsequent line.

To adjust the margins, click the Margins tab and make the required selections.

Tick this box to add
line numbering.

Use to specify whether you
want your changes to affect
the whole document or take
effect from the insertion point.

Use to add space to inside
margins, eg to allow for

binding.

Enter the amount of space you
would like to leave between the

edges of the page and the text
into these boxes.

Check the Mirror margins box if
you are creating a multi-page
document and you would like the

left and right margins on facing
pages to be switched around.
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If you want the options you have chosen for the page layout to be the default for all new

documents based on the same template, click the Default button. The Office Assistant will

prompt you that these changes will affect all documents based on the same template as the

current document.

Once you have made the necessary selections, click OK.

Exercise 3.1

Now do Exercise 3.1 in the Exercise Booklet.

Click Yes to confirm.Click No to exit without
saving the changes.
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3.2 Previewing Documents
Before printing a document, you can use Print Preview to check how it’s going to look.

When you choose the File, Print Preview command you will see the document on the

screen exactly as it will appear on paper. If you need to make any last minute changes, you
can do so within Print Preview.

To begin, select the File, Print Preview menu option or click the Print Preview button on

the toolbar. This button looks like this: .

Print Preview Toolbar

When working in Print Preview, the following toolbar will be displayed.

♦ Print button

Click this button to print one copy of the document.

♦ Magnifier button

When this button appears depressed, magnifier mode is switched on. The mouse pointer

will appear as a magnifying glass, and you can click the page to zoom in and out to see
either the detail on the page or the overall layout of the page.

Print One
Page

Zoom Shrink
to Fit

Close

Magnifier Multiple
Pages

View
Ruler

Full Screen
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If you click the Magnifier button again, Word will switch back to editing mode. While

in editing mode you can click the page then edit your document text as required. Once

you have finished editing, clicking the Magnifier button will disable editing mode, so
you can zoom in and out again.

♦ One Page button

Click this button to display one full page on-screen.

♦ Multiple Page button

Using this button you can display up to 24 pages on-screen at the same time. To display

multiple pages, click the button, and then drag over the number of pages you want to

display on the drop-down grid.

♦  Zoom

To view the current page at a specific size, enter or select the required percentage using

the Zoom box.

♦ View Ruler button

Click this button to display or hide the rulers. Using the rulers you can resize document

margins, set tabs and adjust paragraph indentation.

♦ Shrink to Fit button

When you click this button, Word will attempt to fit your document text onto one less

page than it currently takes up.

♦ Full Screen button

Click this button to remove screen elements including the scroll bars and status bar, so

the document fills the screen. This lets you see more of the document. To return to Print

Preview, press [ESC] or click the Full Screen button once more.

♦ Close button

Click this button to exit Print Preview.
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3.3 Working with Printers

Types of Printer

The printer you use will usually depend on the number of documents you print and the

quality you need. Here are the most common types in use today:

♦ Black and white laser printer: Crisp, high quality black and white output.

Laser printers also have the fastest output rate, so if you know you’ll print a

large number of documents, you should consider a laser printer. A laser

printer uses a replaceable toner cartridge to produce its output.

♦ Colour laser printer: Good for documents that contain high quality graphics such as

photos or charts. These are quite expensive to buy and to run, and a good quality, less

expensive, inkjet printer may print your documents with a similar quality.

♦ Inkjet printer: Produces good quality text, colour charts and graphs, or

photos. With inkjet printers, the paper you use can make a big difference

to the print quality, so you should use paper that is suited to the document

you are printing.

♦ All-in-one printer: Combines printer, scanner and photocopier in one unit.

This type of peripheral is relatively new to the market and is capable of

producing good quality printed output as well as having scanning and

copying capabilities.

If you’re buying a printer, you should try to get a test print from different models so you can

compare the quality. Inkjets can provide very good quality but don’t print as fast as laser

printers. Inkjet printers use ink cartridges, usually separate black and colour, to produce their

output. Cartridges for laser printers can often be expensive, especially for colour printers

where more than one cartridge is needed to mix the range of colours the printer can
reproduce.

Making Sure the Printer is Ready

Before you print a document, you must make sure that the printer is ready to print, ie that it

is online, there’s no paper jam, and it has enough paper and toner or ink.

Checking the Printer is Online

How you do this varies from printer to printer, but all printers have a light that tells you

when they’re online. Usually this light is green or yellow and, if the printer is not ready, the
light will flash to alert you that there is something wrong.

Checking for Printer Problems

If there is a problem with your printer, you will get a message alerting you to it, or

depending on the printer, the error might be displayed on a panel on the printer. For

example, if the printer runs out of paper, you may get a message telling you so, or if your

laser printer needs more toner, a message to this effect will be displayed on its message

panel.
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If your printer has a paper jam (a sheet or sheets of paper are stuck in the printer

mechanism), you should clear it according to the manufacturer’s instructions. This may be

as simple as gently pulling a sheet of paper out of the printer, or it might involve opening
doors on the printer to find all the jammed sheets.
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3.4 Printing Documents

Using Basic Print Options

So far in this course you have printed documents using the Print button on the toolbar.

However, if you want to print multiple copies or only specific pages of a document, or to use

a printer other than your default, you’ll need to use the File, Print menu option. This menu

option displays this dialog box:

Printing a Document

1. Choose the printer you want to use from the Name drop-down list at the top of the

dialog box.

2. Type the number of copies you want to print or use the buttons to enter this number in

the Copies box.

The printer your document
will be output on.

The number of
copies to print

The options for which pages
to print — ‘Current page’

prints the page on which the
cursor is sitting.
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3. Choose which pages you want to print:

♦ All: Select this option button to print every page in the document.

♦ Current: Choose this option to print the page of the document the insertion point is

currently in.

♦ Pages: To print specific pages, type the page numbers and/or page ranges into this

text box. The entries should be separated by commas.

For example, if you want to print pages 1, 3, 20 to 25 and 30, you would type

1,3,20-25,30 into the text box.

4. Click Print to print your selections.

Exercises 3.2 and 3.3

Now do Exercises 3.2 and 3.3 in the Exercise Booklet.

Summary Tasks

Now do the Learning Outcome 3 Summary Tasks in the Exercise Booklet.
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Glossary

A

Alignment The positioning of text on a line or page. For example, a heading may

be centre aligned, ie it is placed evenly spaced between the margins.

Alphanumeric keys The main keypad on the keyboard, primarily used to type letters and

symbols.

Apple Macintosh One of the most common types of computer in homes and schools.

Application

software

Programs that are used to perform a task, such as word processing,

spreadsheets and accounts.

Arrow keys Keyboard keys used to move the cursor around the window.

AutoShapes Ready made shapes that can be added to the document. Includes

rectangles, circles, stars, banners, triangles and lines.

B

Backup A copy of data taken for security purposes, in case of corruption or

accidental deletion/editing of the original data.

C

CD burner CD drive that can write information to CD-ROMs.

CD drive Drive used to read information from a CD-ROM or a CD-RW.

CD rewriter CD drive that can be used to write and change information on a

CD-RW.

CD-ROM Portable disk usually used to distribute large amounts of information

such as programs, eg Microsoft Office. Storage capacity around 780

MB, although this is subject to change as new technology is

developed. A special drive, a CD burner, is required to write

information to a CD-ROM. Information written to a CD-ROM is read-

only, ie it can’t be changed.

CD-RW CD-ROM whose data can be changed. A special CD drive is required

for this task.

Classic Mode Used to run Mac OS 9 programs on a computer with a Mac OS X

system

Clicking Pressing the mouse button once.

ClipArt A collection of sounds, graphic and animations that can be easily

added to your document.
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Clock speed The rate at which processors operate.

Contents Help facility that lists ‘books’ and ‘pages’ of help information.

Contextual menu The menu displayed when you hold down the [CTRL] key and press

the mouse button.

CPU Central Processing Unit. A chip on the logicboard which is where the

processing (the work) takes place.

Cursor Object representing the current position within a program, eg in

Microsoft Word, the cursor is a flashing vertical line.

Cursor keys Keyboard keys used to move the cursor around the window.

D

Desktop The working area on your screen.

Digital camera Pictures taken with a digital camera are stored on a memory card

rather than on film. These images can then be transferred to a

computer for printing or to be adapted.

Digital imaging The process of creating images that can be stored on a computer, eg by

scanning images or downloading them from a device such as a digital
camera.

Digitising tablet See tablet.

Dock Bar shown at the bottom or side of the window which allows you to

start programs using just a single click.

Document A file produced by Microsoft Word or another application program.

Double-clicking Pressing the mouse button twice quickly.

Dragging Moving the mouse from one part of the screen to another with the

mouse button pressed down. Usually used to move items around.

Drive The device used to read and write information to a disk.

Drop-down arrow The small arrow shown at the right side of a drop-down list, used to

open the list.

Drop-down list A list that is hidden while not in use. The list is displayed by clicking

the drop-down arrow at its right side.

DVD Can hold significantly more data that a CD-ROM and is much faster

to access. You need a DVD drive to read a DVD.

DVD drive Drive used to read information from a DVD.
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E

Editing text Changing the contents of a document by adding or deleting text.

F

File Produced by a program such as Microsoft Word or Excel, contains

what you’ve typed as well as information on how it is to be presented.

Finder A program used for working with files and folders, eg to create, move,

copy, rename, search for, or delete them.

Floppy disks 3.5 inch plastic disks that store information magnetically. Storage

capacity from 800K – 1.44 MB. Usually used to carry information

from one computer to another or to backup information for security

purposes.

Folder Part of the filing system that is a container for subfolders and/or files.

Formatting Apply effects to text and paragraphs to enhance the appearance of a

document.

Function keys The top row of keys on most keyboards, numbered from F1 to F10 or

F12. Used within programs to carry out specific tasks.

G

Gigabyte Approximately 1,000 megabytes.

Gigahertz One GHz represents 1 billion cycles per second. The speed of

microprocessors, the clock speed, may be measured in gigahertz. For

example, a microprocessor that runs at 200 GHz executes 200 billion

cycles per second. Each computer instruction requires a fixed number

of cycles, so the clock speed determines how many instructions per
second the microprocessor can execute.

Graphics package A program that is used to create or manipulated graphical data.

GUI Graphical User Interface. Operating system that uses small pictures

called icons to represent tasks and items such as folders and files.

H

Hard disk The permanent disk that is part of your computer. You might have

more than one hard disk on your computer, depending on its setup.

Hardware The hardware of your computer is the physical machinery — the

monitor, the keyboard, the mouse etc.

I

Icons Small pictures that represent tasks and items such as folders and files.
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Indent Extra space left between the left or right margin and the text.

Index Help facility that lets you search a list of key words or phrases.

Insertion point The cursor position in a Word document.

J

JPEG Joint Photographic Experts Group. File format used for digital images

such as those downloaded from a digital camera.

K

Keyboard Input device used for typing information.

L

Logicboard A circuit board housed inside a Macintosh system unit which contains

connections for attaching components such as the CPU, RAM,

monitor, mouse and keyboard.

M

Margin The space left between the edge of the paper and the text.

Megabyte Unit of measurement used in relation to data storage. One megabyte

represents approximately one million bytes (the amount of space
required to store one character of information).

Megahertz One MHz represents one million cycles per second. The speed of

processors, the clock speed, is measured in megahertz. For example, a

processor that runs at 200 MHz executes 200 million cycles per

second. Each computer instruction requires a fixed number of cycles,

so the clock speed determines how many instructions per second the
processor can execute.

Memory The area of the computer where information is stored while the

processing (the work) is carried out on it. May be referred to as RAM.

Memory card Card used by digital cameras and camcorders rather than film to record

images.

Memory stick Large capacity storage device that can be used in the same way as a

floppy disk but can store much more information.

Menu A list of options that you can select from to work with your file.

Menu bar Bar shown at the top of a program window showing words

representing menus of options you can select from to work with your
file.

Microsoft Excel A spreadsheet program.
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Microsoft

Windows

Operating system on a PC.

Microsoft Word A word processing program.

Motherboard A circuit board housed inside a Windows system unit which contains

connections for attaching components such as the CPU, RAM,
monitor, mouse and keyboard.

Mouse Input device used in a GUI-based system to open and run folders, files

and programs.

Multimedia

projector

Output device. Projector that connects to a computer so electronic

presentations can be given.

N

Notepad A simple text processing program supplied as an accessory with

Microsoft Windows.

Network A collection of connected computers.

Numeric keypad Separate keypad that can be set to type numbers. Usually used when

there are a lot of numbers to be typed.

O

Online (internet) When a user is connected to the internet they are said to be online.

Online (printer) When the printer is ready to print it is said to be online.

Optical mouse A mouse that has no roller ball on its base. Movements are sent via

infra-red signal instead.

OS X A program used to help you manage your electronic filing system.

P

Packages Another word for programs.

Peripheral device A peripheral device is one that is connected to your computer, eg

printer, scanner, speakers.

Plain text Text that does not contain any special formatting or fonts.

Point/Point size Measurement used for fonts. 1 point (pt) = approximately 1/72
th

 of an

inch.

Pointing Moving the arrow that represents the mouse to a particular object or

part of the screen.

Printer Output device used to produce printed (or hard copy) versions of files

from the computer.
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Program A list of instructions that are carried out to perform a task. For

example, the Microsoft Word program is a list of instructions that

allow you to carry out various tasks such as editing, saving and spell-
checking documents.

R

RAM Random Access Memory. The area of the computer where information

is stored while the processing (the work) is carried out on it.

Rich text A format that holds information about the formatting and layout of the

document.

ROM- BIOS Built-in software that determines what a computer can do without

accessing programs from a disk. On PCs, the BIOS contains all the

code required to control the keyboard, display screen, disk drives, and
a number of miscellaneous functions.

Ruler Ruler shown above the work area in Word. Can be used to set margins,

tabs and indents.

S

Scanner Input device used to scan existing information so that it is converted to

electronic format.

Scroll bars Positioned at the right and bottom of the program window. Used to

view parts of the file not currently visible.

Serial and parallel

ports

Sockets that can be used to connect peripheral devices such as the

mouse, keyboard or a modem to the Personal Computer.

Shortcut menu The menu displayed when you hold down the [CTRL] key and click

the mouse.

Software The software is what makes your computer do things. For example,

Microsoft Word is a software program (list of instructions) that allows

you to create documents, usually for printing. Another piece of

software on your computer is responsible for displaying (on-screen)

the characters you type using the keyboard on the screen.

Speakers Output device used to transmit sound from the computer and its

programs.

Spreadsheet A file produced by, for example, Microsoft Excel, Lotus, Filemaker.

Status bar Bar shown at the bottom of the program window containing status

information about the file and the program.

Subfolder A folder that is stored inside another folder.
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System software Programs that make your computer work. Examples of tasks that

system software carries out include file management, printing and

displaying the characters you type using your keyboard on the screen.

System unit The ‘box’ part of your Personal Computer which houses the various

components that make your computer work, eg CPU, RAM,
motherboard.

T

Tablet Also known as digitising tablet. Input device where the user drags an

electronic pen across the surface of the tablet to enter drawings into the

computer.

Tapes and

cartridges

Large capacity storage, but low access speed. Usually used for backing

up data.

Text area The part of the Word window representing the printed page.

TextEdit A simple text processing program supplied as an accessory with Apple

Macintosh computers.

Toolbar Bar shown at the top of the program window containing buttons

representing shortcuts to some of the menu options available.

U

Upgrade The process of replacing older hardware or software with newer

versions.

V

VDU Visual Display Unit. Used to show you what is happening on your

system.

W

Wireless mouse A mouse that is not connected directly to the computer via a cable.

Usually made up of two parts, the wireless mouse and a separate unit

that is connected to the computer.

Z

Zip drive Large capacity storage, typically around 100 MB. Special disks look

like large floppy disks.
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A
Aligning Drawn Objects 50

Alignment 56

Anti-virus Software 12

Applications Software 12

Arrow Keys 13

AutoCorrect 37

AutoShapes 48

adding 49

adding text 49

B
Bulleted Lists 42

C
Calendar Software 12

[CAPS LOCK] Key 14

CD-ROMs 6

Central Processing Unit 5

Checking Spelling 51

Clicking 15

ClipArt

Adding 46

Closing a Document 29

Closing Word 24

Collapsing Drives and Folders 19

Common Text Formats 29

Computer Software 10

Computer-based Training 12

Connections 5

Control-Click 15

Copying Files 19

Copying Folder 19

Copying Text 40

Correcting Mistakes

as you type 37

CPU 5

Creating

Documents 35

Folders 20

Cursor Keys 13

Customising Page Setup 55

D
Database Software 12

Deleting

folders and files 20

Desktop 11

Digital Camera 7

Digital Imaging. See Graphics

Digitising Tablets 7

Disks

CD-ROMs 6

DVDs 6

Floppy 5

Zip 5

Documents

Closing 25

Creating 35

Opening 25

Previewing 58

Printing 60

Saving 25

Double Clicking 15

Drawing Toolbar 48

Drawings

adding AutoShapes 48

adding ClipArt 45

adding text 49

aligning objects 50

AutoShapes 48

formatting objects 50

moving 49

resizing 50

selecting objects 49

Drives and Folders in Word 20

DVDs 6

E
Editing Text 37

moving the insertion point 39

using the keyboard 40

using the mouse 39

E-mail Software 12

[ENTER] Key 13

Entering and Editing Text

AutoCorrect 37

Entering Text 37

Expanding

Drives and Folders 19

Explorer 12
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F
Files 17,18

Deleting 20

Finder 18

Floppy Disks 5

saving files to 26

Folders 17

Creating 20

Deleting 20

Organisation 17

Formatting

Alignment 50

bulleted lists 42,43

indents 42

line spacing 42

Formatting Drawn Objects 50

Formatting Paragraphs 42

Formatting Text 41

Formatting Toolbar 43

Function Keys 13

G

Glossary 64

Graphical User Interface 6,10

Graphics 7,45

Inserting 45

text wrapping 47

GUI 6,10

H
Hardware 4

Help 30

Office Assistant 30

Highlighting Text 40

using keyboard 40

I

Images

adding AutoShapes 48

moving 49

Indents 42

Index 71

Information Technology 3

Input Devices 6

Inserting Graphics 45

Insertion Point

Moving 39

J
Joysticks 7

K
Keyboard 13

Keys

[BACKSPACE] 13

[CAPS LOCK] 14

[ENTER] 13

[SHIFT] 14

cursor/arrow 6,13

Function 13

L
Learning Outcome 1 1

Learning Outcome 2 33

Learning Outcome 3 53

Light Pens 7

Line Spacing 42

Logicboard 4

M
Margins

Changing 55

Memory Sticks 5,67

Menu Bar 23

Microsoft Windows 10

Mistakes

correcting as you type 37

Modem 4

Monitors 8

Mouse 6

controlling 15

using 14

Moving Drawings 49

Moving Files 19

Moving Folders 19

Moving Text 40

Moving the Insertion Point 39

Multimedia Projectors 8

N
Numeric Keypad 13

O
Office Assistant 30,57

Opening a Document 25

Opening Word 22

Operating System Software 10

Orientation

Changing 55

Output Devices 8
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P
Page Setup

Changing 55

Paragraph Formatting 42

Peripherals 4

Personal Computer 4

Pictures

Moving 49

Plotters 8

Pointing 14

Pointing Devices 7

Presentation Graphics Software 12

Previewing Documents 58

Print Preview 58

Toolbar 58

Printers 60

Printing a Document 62

Printing Documents 62

basic print options 62

Projectors 8

Q

QWERTY Keyboard 13

R
RAM 4

Redo 38

Removable Storage Media 5

Resizing Drawings 50

Ruler 23

S
Saving a Document 26

Scanner 7

Screen Elements 22

menu bar 23

ruler 23

scroll bars 23

status bar 24

text area 23

toolbars 23

Screens. See Monitors

S continued
Scroll Bars 23

Selecting Drawn Objects 49

Selecting Text

Selecting 39

using keyboard 40

using the mouse 39

[SHIFT] Keys 13

Software 3, 10

anti-virus 12

applications 12

calendaring 12

computer-based training 12

database 12

email 12

operating systems 10

presentation graphics 12

spreadsheet 12

web browser 12

word processing 12

Sound 8

[SPACEBAR] 13

Speech 7

Spell Checking 51

Spreadsheet Software 12

Starting Word 22

Status Bar 24

Steering Wheels 7

Summary Task

Learning Outcome 1 31

Learning Outcome 2 52

Learning Outcome 3 63

Switching Off Your Computer System 9

Switching On Your Computer System 9

System Unit 4

T
Tablets 7

Tapes 6

Text

adding to drawings 49

copying 40

entering and editing 37

highlighting 39

moving 40

Text Area 23

Text Formats 29

Text Formatting 41

Text Wrapping around Graphics 47

Toolbars 23

Drawing 50

Formatting 41,43

Print Preview 58

Touchpads 7
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U
Undo 38

Reversing 38

Using

Mouse 14

Using the Keyboard 13

V

VDUs. See Monitors

Vertical Alignment

Changing 56

Views

Print Preview 58

Visual Display Units. See Monitors

W
Web Browser Software 12

Web Cameras 7

Windows 10

Word Help 30

Word Processing Software 12

Working with Printers 60

Wrapping Text around Graphics 47

Z
Zip Disks 5


